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ΕΙΣΑΓΩΓΗ 

 
Στο δοκίμιο αυτό περιγράφεται μοντέλο ανάλυσης μεταλλικών κατασκευών στο 

πρόγραμμα SCIA Engineer. Το SCIA Engineer είναι ένα σύστημα λογισμικού για μια στατική και 
δυναμική ανάλυση των δομικών στοιχείων και το σχεδιασμό τους σε πρότυπα. Βασίζεται στη 
μέθοδο πεπερασμένων στοιχείων με βάση τη μετατόπιση (displacement - base FEM).  
 
Το πρόγραμμα SCIA Engineer περιλαμβάνει τους ακόλουθους υπολογισμούς: 
 

• γραμμική στατική ανάλυση 

• γεωμετρική μη γραμμική ανάλυση 

• δυναμική ανάλυση φυσικής ταλάντωσης 

• σεισμική ανάλυση 

• ανάλυση λυγισμού 

Ίσως από τους πιο σημαντικούς παραμέτρους για να επιτευχθεί το επιθυμητό αποτέλεσμα στη 
μελέτη, είναι ο σωστός σχεδιασμός του μοντέλου. Τα υλικά που θα εισαχθούν στο πρόγραμμα, η 
σωστή γεωμετρία, τα χαρακτηριστικά των υλικών, είναι ορισμένες από τις κύριες παραμέτρους 
που επηρεάζουν τη συμπεριφορά του μοντέλου. 
 

Μέσα από το πρόγραμμα SCIA Engineer, ο χρήστης μπορεί να καθορίσει το δικό του υλικό 
που θα χρησιμοποιήσει για το σχεδιασμό του μοντέλου ή να χρησιμοποιήσει έναν 
προκαθορισμένο τύπο υλικού από τη βάση δεδομένων της SCIA Engineer. Μέσα από το 
σχεδιασμό του δικού του υλικού, ο χρήστης πρέπει να καθορίσει τις ιδιότητές του υλικού, οι οποίες 
είναι απαραίτητες για τον υπολογισμό του βασικού πεπερασμένου στοιχείου του μοντέλου, διότι 
χωρίς αυτές δεν είναι δυνατή η ανάλυση του μοντέλου. Αν ο χρήστης, επιθυμεί να προσθέσει 
επιπλέον τύπο υλικού αργότερα, μπορεί οποιαδήποτε στιγμή αργότερα (δηλ. όχι μόνο κατά τη 
διάρκεια της φάσης της δημιουργίας του έργου). 
 

Μια διατομή ορίζεται μέσω του τύπου και των διαστάσεών της. Τα χαρακτηριστικά διατομής 
υπολογίζονται αυτόματα από το πρόγραμμα SCIA Engineer. Τα χαρακτηριστικά της διατομής 
όπως η τομή, η ροπή αδράνειας, η θέση του κέντρου βάρους κ.λπ. υπολογίζονται αυτόματα από 
το πρόγραμμα. 
 

Μέσα από το πρόγραμμα, ο χρήστης έχει τη δυνατότητα σχεδίασης συνδέσεων πλαισίων 
μεταλλικών κατασκευών. Ενώ εισάγεται μια σύνδεση στα γραφικά παράθυρα του SCIA Engineer, 
κάθε στοιχείο της σύνδεσης σχεδιάζεται (συνδεδεμένα μέλη, ακραίες πλάκες, μπουλόνια κλπ.). 
Επιπλέον, οι επιτρεπόμενες δυνάμεις στη σύνδεση υπολογίζονται και πρέπει να συγκριθούν με τις 
πραγματικές δυνάμεις που δρουν στη σύνδεση. Το πρόγραμμα περιλαμβάνει επίσης τα μέρη που 
καθορίζουν την αντίσταση της σύνδεσης, επιτρέποντας έτσι στον χρήστη να λάβει τις κατάλληλες 
ενέργειες. Μετά το σχεδιασμό και τον υπολογισμό, το πρόγραμμα μπορεί να δημιουργήσει σχέδια 
λεπτομερή σχέδια της σύνδεσης. 
 

• Steel member check  

 
  

mailto:info@masesoft.com
https://help.scia.net/18.1/en/index.htm#rou/steel/steel_code_check_setup_dialogue_ec_en.htm%3FTocPath%3DDesign%2520of%2520steel%2520members%7CParameters%2520and%2520settings%2520for%2520code%2520checks%7C_____3


7 
 

Official Partner of SCIA in Cyprus 
 

Franklin Roosevelt 193, 3045, Limassol, Cyprus 

Tel: +357 25251718, Mob: +357 97614727 

Email: info@masesoft.com 

PROCESS FOR CALCULATION 

 

1. New Project 

File → New or Blank Project 

 

2. Project data 

Project data → Basic data → Material (Concrete, Steel) 
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2.1. Functionality  

 

1η Στήλη 2η Στήλη 

Climatic loads   √ Dynamics 
- Seismic spectral analysis   √ 

Dynamics   √ Subsoil 

- Pad foundation   √ 

Structural model   √ Steel 

-Steel connections   √ 

Ok!! 
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2.2. Actions 

Loads → Wind load (according to code – για Κύπρο CY 24 m/sec – 40 m/sec – usually 30 m/sec) 

→ Snow load (according to code) 

→ Model factor - 1.30 

→ Seismic Combinations → Factor for concomitant components - 0.3 

→ OK! 

In case if being not sure how to create the combinations at the ‘’Code Combinations’’ 

choose ‘’Automatic’’ option. 
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3. Κάνναβος 

 

Main → Line grid and storeys → 3D line grid  

→ Span Dr (X), Span Dr (Y)  Dr (Z)  → OK 

At the command window write ‘’0’’ to add it on the 0,0,0 UCS → Enter 
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➔ Τοποθετούμε τον κάνναβο στο X,Y,Z 

➔ Για να κρύψω προσωρινά τον κάνναβο :   

 
 

 

Intro to View Parameters, Units & Member Properties 

 

• https://www.youtube.com/watch?v=rUfvER8TQrM&index=10&list=PL0OvQw2kgGq6

RgBwrQj7cx0kCskBg5FCW 
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3.1. Import CAD files: 

Main → Structure → Modelling / Drawings → Import DWG, DXF, VRML97. 

 
 

 

Import CAD Files 

 

• https://www.youtube.com/watch?v=Znp1-

OV7cOo&index=11&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW 

 

Import IFC 

 

• https://www.youtube.com/watch?v=Wwa3TlAf9K4&index=12&list=PL0OvQw2kgGq6

RgBwrQj7cx0kCskBg5FCW 
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3.2. Snap Settings 

  

 
 

Cursor Snap Settings 

 

• https://www.youtube.com/watch?v=WbH_KtSsD14&index=9&list=PL0OvQw2kgGq6R

gBwrQj7cx0kCskBg5FCW 
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4. Layers 

➔ Για όλες τις διατομές και πλάκες ανά όροφο. 

 
 

 
 

 

Ta ‘’Layers’’ προσφέρονται για να 

μπορείτε να έχετε καλύτερο 

έλεγχο της κατασκευής σας. 

Επίσης, χρησιμεύει στην 

αυτόματη διαστασιολόγηση 

(Autodesign) γιατί μπορώ εύκολα 

να φιλτράρω τα μέλη μου μέσω 

των ‘’Layers’’. 

Η επιλογή ‘’Structural model only’’ 

σημαίνει ότι, τα μέλη σας που 

βρίσκονται σε αυτό/α τα ‘’Layer’’ 

που έχει αυτή την επιλογή, το 

SCIA Engineer δεν θα σας κάνει 

την ανάλυση του/των 

συγκεκριμένων μελών. 

 

Μόλις όμως προχωρήσετε σε 

ανάλυση θα σας ειδοποιήσει εάν 

έχετε κάνει αυτή την επιλογή. 
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5. Γεωμετρία 

 
Cross section → Προσθέτω όλες τις διατομές που θα χρησιμοποιηθούν στο σχεδιασμό του 
μοντέλου.  
 

 
 

 
 

 
 

Μπορώ να χρησιμοποιήσω και το 
κουμπί των Cross-sections (Ctrl+J) 
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5.1. 1D Members 

Main → Structure → 1D member → member (Beam or Column) 
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Για να φαίνεται το κτήριο όπως θα είναι στη πραγματικότητα (Structural model) πατώ:  

 

Input of 1D members 

 

• https://www.youtube.com/watch?v=39k0M9176ic&index=5&list=PL0OvQw2kgGq6Rg

BwrQj7cx0kCskBg5FCW 
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Για να σπάσω μια δοκό θα πρέπει να επιλέξω τη δοκό και να πατήσω την εντολή “Break in 

defined points” και να επιλέξω τους κόμβους στο σημείο που θέλουμε να σπάσει και μετά Esc 

 
 

 

6. Στηρίξεις  

➔ Για θεμελίωση άκρων των κολώνων / δοκών επιλέγω και βάζω πάκτωση   

➔ Για τους κόμβους: Main → Structure → Model data → Support → In node  

 

 

 

 

Main → Structure → Model data → Hinge on beam (i.e change fix or/and fiz to free) 

Αυτό γίνεται συνήθως όταν έχω κάποιες δευτερεύουσες οι οποίες κατά την γνώμη του 

Πολιτικού Μηχανικού δεν μεταφέρουν π.χ. ροπές κάμψης κτλ. 

 

 

Input of Supports 

 

• https://www.youtube.com/watch?v=EG8XWmtsp8g&index=8&list=PL0OvQw2kgGq6

RgBwrQj7cx0kCskBg5FCW  
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7. Έλεγχος Γεωμετρίας 

 

Main → Structure → Check structure data → Check → Continue → OK 

Αυτό γίνεται πάντα μετά από την σύνδεση των μελών μας (Connect Members/Nodes) για να δούμε 

τυχόν διπλές ονομασίες, ασύνδετα μέλη και γενικά προβλήματα του στατικού μας φορέα. 
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8. Load Panels 

8.1. Load to panel edges and beams  

 

Structure → Load Panels → Load to panel edges and beams  

-Layer → Load panel  

-Load transfer method → Tributary area  

-Max eccentricity of members = 0.2 m (Default) 

 
 

8.2. Plates 

Structure → Load panels → Load to panel edges & beams  
   or 

   → 2D Members → Plates → Plate (Concrete) 
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Όποιες και αν είναι οι επιλογές μου μπορούν πολύ εύκολα να αλλάξουν μέσω του παραθύρου 
αριστερά ‘’Properties’’. 

Creating and Using Load Panels 

 

• https://www.youtube.com/watch?v=vRAWR_i5mBo&list=PL0OvQw2kgGq6RgBwrQj7

cx0kCskBg5FCW&index=19 

 

Input of 2D members: plates, walls 

 

• https://www.youtube.com/watch?v=R8ocFcA6HwA&list=PL0OvQw2kgGq6RgBwrQj7

cx0kCskBg5FCW&index=6 

 

 

Για άνεμο βάζω ‘’Load Panel’’ σε όλους τους τοίχους / πλάκες (3D WIND)  

 

➔ Το τοξάκι πρέπει να βλέπει προς τα έξω – Αν όχι → Double Click στο τοξάκι →Swap 

outer surface  

➔ Για οροφή αν βάλω ‘’2D Plate’’ (Properties → 3D WIND) 

➔ Με αυτό τον τρόπο βοηθώ το SCIA Engineer να δημιουργήσει αυτόματα όλες τις 

διευθύνσεις ανέμου που θα επηρεάσουν το κτίριο μου. 
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8.3. Load Cases  

 
Main → Load Cases  
(Selfweight, Dead, Dead Partitions, Dead Roof, Dead Cantilevers, Live, Live Roof, Live Cantilever, etc.)  

Or  

Main → Tree → Load Cases 
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Τα ‘’Load group’’ για 

τα ‘’Self weight’’ και 

για τα ‘’Dead loads’’ 

δημιουργούνται 

αυτόματα. 

 

Για τα ‘’Live loads’’ 

πρέπει ο χρήστης να 

επιλέξει πατώντας τις  

τελείες για να 

δημιουργήσει ένα νέο 

‘’Load group’’ με την 

κατηγορία που 

επιθυμεί π.χ.  

Cat A: Domestic 

δηλαδή κατοικίες.  

Eurocode 0, Annex 

A1, table A1.1. 
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Δεν βάζω σεισμικά ‘’Load cases’’ ακόμη γιατί δεν έχω φορτίσει την κατασκευή μου με τα 

μόνιμα φορτία (Dead loads) και τα κινητά φορτία (Live loads) τα οποία θα μου δώσουν τις 

σεισμικές μάζες (Mass Groups / Combination of mass groups) και άρα τα σεισμικά ‘’Load 

cases’’. 

 

Creation of Load Groups and Cases 

 

• https://www.youtube.com/watch?v=CdtFbUKsMPA&index=13&list=PL0OvQw2kgGq6

RgBwrQj7cx0kCskBg5FCW 

 

Creation of Load Combinations 

 

• https://www.youtube.com/watch?v=p6CH4Mini-

A&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW&index=14 
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8.4. Loads  

Loads → Dead → Surface load → On 2D member 

 

Οι φορτίσεις εισάγονται αναλόγως της κατασκευής μας. 

 

 

 

Loads → Live → Surface load → On 2D member  

Τα κινητά φορτία εισάγονται σύμφωνα με το παράρτημα της κάθε χώρας! ΑΝ επιθυμείτε μπορείτε 

να τα αυξήσετε. 

Στην Κύπρο: 

Πλάκες (βατές): 2 kN/m2, Πλάκες (Μη βατές): 0.4 kN/m2 

Κλιμακοστάσια: 3 kN/m2 

Πρόβολοι: 4 kN/m2 
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3D Wind Load Generator 

 

• https://www.youtube.com/watch?v=6JLwonXonWw&list=PL0OvQw2kgGq6RgBwrQj7

cx0kCskBg5FCW&index=16 

 

Input of Free Surface Loads 

 

• https://www.youtube.com/watch?v=7qkUG7B-

Jdc&index=17&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW 

 

Creation of Basic Loads 

 

• https://www.youtube.com/watch?v=iSaQG7Lgl1w&index=15&list=PL0OvQw2kgGq6R

gBwrQj7cx0kCskBg5FCW 
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9. Connect Members/nodes  

Main → Structure → Model data → Connect members / nodes → Check  → Yes   

 

Πριν να γίνει η ένωση των κόμβων πρέπει να σιγουρευτείτε για τη γεωμετρία. Αν προκύψει 

οποιαδήποτε αλλαγή θα πρέπει να ξαναγίνει η σύνδεση των κόμβων. Επίσης, αν ο χρήστης 

πρόκειται να μετακινήσει κάποιο κόμβο ή μέλος πρέπει να τα αποσυνδέσει (Disconnect 

members/nodes) γιατί θα μετακινηθούν και τα υπόλοιπα μέλη που είναι συνδεδεμένα μεταξύ τους. 
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10. Mesh generation   

 Πρέπει να γίνει αμέσως μετά που θα φορτιστεί η κατασκευή, ούτως ώστε να μεταφερθούν τα 

φορτία σωστά και να μπορέσουν μετά να δημιουργηθούν οι σεισμικές μάζες. 

 

Intro to Mesh Setup & Generation 

 

• https://www.youtube.com/watch?v=CBs068SBH1Y&list=PL0OvQw2kgGq6RgBwrQj7cx0k

CskBg5FCW&index=20 

 

 
11. Mass Groups  

Main → Dynamics → Mass groups (Selfweight, Dead, Live, etc.) 
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12. Combination of Mass Groups  

 

Main → Dynamics → Combination of mass groups → Add All → OK 

➔ MG3 = Live Load → Coeff.= 0.3 (70% απομείωση)  

➔ For ‘’Dead’’ and ‘’Live’’ loads below surface (also with ground floor) are NOT added to 

the ‘’Combination of mass groups’’ because masses below ground surface are NOT 

calculated. 

➔ For ‘’Live’’ loads for seismic combination above ground (0+) → Used Coeff. = 0.3  

➔ Code: ΨΕi = φ x ψ2i = 0.3 (Residential φ = 1, ψ2 = 0.3) - Table A1.1 + A1.2(B) (CYS) 

 

 

 

Αυτό γίνεται για όλες τις μάζες εκτός από τα ‘’Free load’’ τα οποία δεν συμπεριλαμβάνονται εδώ. 
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13. Seismic X 

Main → Load cases → New → Seismic X 
 

➔ Create one new load group LG3 (Together And Seismic)  

➔ Dynamic → Seismicity → Check the direction X 

 

14. Seismic spectrums  

Libraries  → Loads → Seismic spectrums (q-factor i.e. for Steel) 
➔ Type drawing → Period 

➔ Info short → Eurocode 

 

Edit → Code parameters  

 

mailto:info@masesoft.com


31 
 

Official Partner of SCIA in Cyprus 
 

Franklin Roosevelt 193, 3045, Limassol, Cyprus 

Tel: +357 25251718, Mob: +357 97614727 

Email: info@masesoft.com 

 

➔ Code parameters   

➔ Coeff. accel. ag (AgR)= AgR * γi= 0.25 * 1= 0.25 

➔ ag – design acceleration= 0.25 * 9.81= 2.453 m/s2 

➔ q factor= 2.5 

➔ beta= 0.20 

➔ Subsoil= C 

➔ Spectrum type= Type 1 

➔ Direction= Horizontal  

 

➔ To γi τροποποιείται ανάλογα σε ποια κατηγορία σπουδαιότητας είναι το κτήριο.  

 

Κατηγορίες Σπουδαιότητας (γi) 

Κατηγ. Ι (Φάρμες) 0.8 

Κατηγ. ΙΙ (Κατοικίες) 1.0 

Κατηγ. ΙΙΙ (Σχολεία κλπ) 1.2 

Κατηγ. ΙV (Νοσοκομεία κλπ) 1.4 
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Κατά τον Ευρωκώδικα 8 (σε κτίρια) η κατακόρυφη συνιστώσα χρειάζεται να λαμβάνεται υπ' όψη 
εάν η μέγιστη κατακόρυφη επιτάχυνση avg, είναι μεγαλύτερη από 0,25g δηλαδή, στη Ζώνη  
Επικινδυνότητας 2 = 0.20 (μόνο για την γi = ΙV), καθώς και στην Ζώνη  Επικινδυνότητας 3 = 0.25 
μόνο για τις κατηγορίες σπουδαιότητας (γi = III και ΙV), αλλά και πάλι μόνο στις ακόλουθες 
περιπτώσεις: 
 
– για (σχεδόν) οριζόντια μέλη με άνοιγμα τουλάχιστον 20m 
– για (σχεδόν) οριζόντιους προβόλους με άνοιγμα μεγαλύτερο από 5m 
– για (σχεδόν) οριζόντια προεντεταμένα μέλη 
– για δοκούς που στηρίζουν φυτευτά υποστυλώματα 
– σε κτίρια με σεισμική μόνωση. 
 
Για την παρούσα μελέτη ισχύει avg = AgR*γi*0.9 = 0.9*1*0.25g = 0.225g < 0.25g.  
 
Άρα δεν θα ληφθεί υπόψη η κατακόρυφη συνιστώσα του σεισμού στη μελέτη της υπ' όψη 
κατασκευής θεωρώντας ότι η επιρροή της καλύπτεται από τους συντελεστές ασφαλείας γg=1,35 
και γq=1,50 στον συνδυασμό βασικών δράσεων χωρίς σεισμό, και από τα υφιστάμενα περιθώρια 
αξονικής αντοχής των κατακόρυφων στοιχείων.  
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15. Load  - CQC 

➔ Load cases → SEISMIC X → Modal Superposition → Type of superposition → CQC 
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➔ Edit  

➔ Frequency 10000 (έλεγχος σε ευρύ φάσμα συχνοτήτων) 

➔  Damping (ξ) 3% - 5% (Concrete, Steel, Timber) 
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16. Combinations  

➔ List of load cases -> Combinations → Insert → Add ( Selfweight / Dead / Live) 

➔ Name – SLS 

➔ Type – EN-SLS characteristic → Yes → OK 

 

➔ ULS Set B, ULS Set C with SW, DL, LL loads and with Wind load cases 

➔ Name – ULS Set B 

➔ Type – EN-ULS Set B → Yes → OK 

 

➔ Name – ULS Set C 

➔ Type – EN-ULS Set C → Yes → OK 

 

➔ Name – Seismic X (0.3Y) Απομειώνω τον σεισμό στο Υ κατά 70% 

➔ Type – EN-Seismic → Yes → OK 

 

➔ Name – Seismic Y (0.3X) Απομειώνω τον σεισμό στο Χ κατά 70% 

➔ Type – EN-Seismic → Yes → OK 
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Τα ‘’Load cases’’ για τον 

άνεμο δημιουργούνται 

αυτόματα και ο χρήστης 

πρέπει να τα εισάγει εδώ, 

δηλαδή στον συνδυασμό 

‘’ULS’’ γιατί ο κανονισμός μας 

επιτρέπει να ΜΗΝ έχουμε δυο 

(2) τυχηματικές δράσεις να 

εισάγονται μαζί στην ανάλυση 

μας (Άνεμος και Σεισμός μαζί). 

Αυτό είναι εφικτό γιατί είναι 

αρκετά σπάνιο γεγονός να 

συμβούν ταυτόχρονα. 

 

To SCIA Engineer δημιουργεί 

αυτόματα όλες τις διευθύνσεις 

ανέμου που θα επηρεάσουν 

το κτίριο μου οι οποίες θα 

φαίνονται στην δεξιά λίστα 

‘’List of load cases’’. 
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• Combinations containing seismic load cases 
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17. Result classes  

➔ Tree → Load case → Result classes  

➔ SLS 

➔ ULS 

➔ RC1 (SEISMIC) → είναι μια περιβάλλουσα συνδυασμών  

➔ GEO (ULS Set C) 

 

 

 

Χρειάζεται προσοχή όταν αναλύεται μια κατασκευή με δυναμική φόρτιση στο SCIA Engineer έτσι 

η MASES SOFTWARE προτείνει να δείτε την παρακάτω ιστοσελίδα της SCIA. 

 

• Dynamic analysis troubleshooting  
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3D WIND 

 

Τοποθετώ ‘’Load Panel’’ σε όλους τους τοίχους / πλάκες (3D WIND)  

 

→Το τοξάκι πρέπει να βλέπει προς τα έξω – Αν όχι → Swap outer surface  

→Για οροφή χρησιμοποιείται 2D plate (Properties → 3D WIND) 

→Με αυτό τον τρόπο βοηθώ το SCIA Engineer να δημιουργήσει αυτόματα όλες τις 

διευθύνσεις ανέμου που θα επηρεάσουν το κτίριο. Ο άνεμος μπορεί να δημιουργηθεί στο 

πρόγραμμα πριν ή και μετά το βήμα 8 (βλέπε σελίδα 20) 

 

18.  3D Wind to Load Panels 

 
Main → Load Panels → Load to panel edges 
 

Layer → Load Panels  

Load transfer direction → X (LCS panel)  

Load transfer method → Tributary area 

 

Ενώνω κόμβο σε κόμβο και δημιουργείται το ‘’Load Panel’’. ΠΡΟΣΟΧΗ το τοξάκι πρέπει να δείχνει 

πάντοτε έξω από την κατασκευή μου. Αν όχι, πατώ στο τοξάκι και από την εντολή swap outer 

surface πατώ . 
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18.1. Load → 3D Wind Generation  

Main → Load → 3D Wind Generation → Add Load Cases → OK 
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18.2. Load Case, Combinations → Load Case 

Main → Load Case, Combinations → Load Cases  
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18.3. Load Cases, Combinations → Combinations  

Main → Load Cases, Combinations → Combinations → ULS Set B  
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19. CALCULATION 

 

19.1. Calculation  

Main → Calculation/ Mesh → Calculation  

 

 

Running an Analysis, Check Structure Data and Connect Nodes/Members 

 

• https://www.youtube.com/watch?v=aq1S51ebBtw&list=PL0OvQw2kgGq6RgBwrQj7cx0k

CskBg5FCW&index=21 
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19.2. Mesh setup 

 

Main → Calculation / Mesh → Mesh setup  

Δείχνει σε πόσα μέρη θα γίνει η ανάλυση των πεπερασμένων στοιχείων 

 

➔ Αν επιθυμώ να το κάνει το πρόγραμμα: Advanced mesh settings → Automatic  

Πρέπει όμως να επιλέξω ‘’Load cases’’. 

 

• https://resources.scia.net/en/articles/analysis/15_3_automatic_mesh_refinement_im

provement.htm 

 

Automatic mesh refinement in SCIA Engineer 16 

 

• https://www.youtube.com/watch?v=P5RoDSnMGy0 

 

 

 

➔ Average number of tiles of 1D element → 4  

➔ Average size of 2D element/curved element → 0.25 (0.20 - 0.30) 

Το μέγεθος του πλέγματος (mesh) του επιφανειακού πεπερασμένου στοιχείου (2D 

member) εξαρτάται από το πάχος του και πόσο πυκνό το θέλει ο μελετητής. 
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19.3. Solver setup 

Main → Calculation/ Mesh → Solver setup 

- Number of eigenmodes → 30 

 

Το IRS χρησιμοποιείται όταν το μοντέλο είναι τουλάχιστον 2 ορόφων και άνω. 

Το IRS μου προτείνει τον ακριβή αριθμό ιδιομορφών (eigenmodes) !!! 

 

• http://masesoft.com/seismic-design.html 

 

 

 

Σε περίπτωση που ο χρήστης αντιμετωπίζει λάθη στο μοντέλο, υπάρχουν τα βοηθήματα 

(help.scia.net): 

 

• IRS: Too many eigen values requested / Non-associated R-node detected 

 

• Issue: incorrect sum of masses 

 

• Issue: total base shear is not the sum of modal values 

 

 

 

 

 

 

 

 

 

 

mailto:info@masesoft.com
http://masesoft.com/seismic-design.html
https://help.scia.net/18.1/en/
https://help.scia.net/18.1/en/index.htm#sr/seismic_analysis_of_buildings/irs_non_associated_r-node.htm%3FTocPath%3DTheoretical%2520background|Dynamics|Dynamics%2520troubleshooting|Dynamic%2520analysis%2520troubleshooting|Troubleshooting|_____1
https://help.scia.net/18.1/en/index.htm#sr/dynamic_analysis_troubleshooting/issue_mass_does_not_match_hand_calc.htm%3FTocPath%3DTheoretical%2520background%7CDynamics%7CDynamics%2520troubleshooting%7CDynamic%2520analysis%2520troubleshooting%7CTroubleshooting%7C_____2
https://help.scia.net/18.1/en/index.htm#sr/dynamic_analysis_troubleshooting/issue_base_shear_sum.htm%3FTocPath%3DTheoretical%2520background%7CDynamics%7CDynamics%2520troubleshooting%7CDynamic%2520analysis%2520troubleshooting%7CTroubleshooting%7C_____3
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19.4. Calculation protocol 

 

Main → Results → Calculation protocol → Type: Eigen frequency → Preview 

• http://masesoft.com/seismic-design.html 

 

 

 

 
 

Πρώτα γίνεται μια φασματική ανάλυση ούτως ώστε ο χρήστης να μπορεί να δει την συμπεριφορά 

του κτηρίου και εφόσον είναι ικανοποιημένος τότε μπορεί να προχωρήσει σε γραμμική και 

δυναμική ανάλυση (Linear Analysis) για έλεγχο πλέον του στατικού φορέα.  

• Validation of modal analysis: mode shapes 

 

• Validation of modal analysis: relative modal masses 

 

mailto:info@masesoft.com
http://masesoft.com/seismic-design.html
https://help.scia.net/18.1/en/index.htm#sr/dynamic_analysis_troubleshooting/validation_modal_analysis_mode_shapes.htm%3FTocPath%3DTheoretical%2520background%7CDynamics%7CDynamics%2520troubleshooting%7CDynamic%2520analysis%2520troubleshooting%7CValidation%2520of%2520modal%2520analysis%7C_____2
https://help.scia.net/18.1/en/index.htm#sr/dynamic_analysis_troubleshooting/validation_modal_analysis_modal_masses.htm%3FTocPath%3DTheoretical%2520background%7CDynamics%7CDynamics%2520troubleshooting%7CDynamic%2520analysis%2520troubleshooting%7CValidation%2520of%2520modal%2520analysis%7CCalcula
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20. RESULTS 

 

20.1. Linear Analysis 

Run LINEAR Analysis ONLY (Συμπεριλαμβάνεται και ο σεισμός) 
 
Main → Results  

 

20.2. Displacement of nodes  

 

 

Ο χρήστης μπορεί να επιλέξει κάποιους κόμβους (nodes) της επιλογής του για να παρατηρήσει 

την μετατόπιση τους (Displacement), αλλιώς το πρόγραμμα θα δώσει αποτελέσματα 

μετατοπίσεων όλων των κόμβων του κτιρίου. 
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20.3. 3D displacement 

Main →Results → 3D displacement  

 

 

 

Παρατηρείται ότι η μεγαλύτερη μετακίνηση είναι στο κέντρο της πλάκας του κτηρίου, με μετακίνηση 

που κυμαίνεται από 4 έως 4.5 χιλιοστά (mm)! Αν ο χρήστης επιθυμεί μικρότερη μετακίνηση του 

δίνεται η δυνατότητα να αλλάξει τις διαστάσεις των δευτερευουσών δοκών σε μεγαλύτερες 

διαστάσεις.  

Με την εντολή Wireframe, παρουσιάζεται το κτήριο σε γραμμική μορφή. 

 

Main → Results → 3D displacement → Wireframe  
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20.4. 3D stress 
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21. Supports 

21.1. Reactions 

Main → Results → Supports → Reactions 

 

Με την εντολή ‘’Type of Loads’’  γίνεται επιλογή ‘’Load cases’’, αν όμως εμφανίζεται αστεράκι (*) 

δίπλα από τα ‘’Load cases’’ (δλδ, Load cases*) τότε το πρόγραμμα δεν έχει τρέξει σε ‘’Linear 

Analysis’’ αλλά μόνο σε ‘’Modal Analysis’’ (Μόνο φασματική).  

 

• https://www.youtube.com/watch?v=MAL0ia01zIY&index=22&list=PL0OvQw2kgGq6RgB

wrQj7cx0kCskBg5FCW 

 

 

21.2. Beams 

21.2.1. Internal forces of beam 

Main → Results → Beams → Internal forces of beam  

(It includes Columns and Beams) 

 

 

mailto:info@masesoft.com
https://www.youtube.com/watch?v=MAL0ia01zIY&index=22&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW
https://www.youtube.com/watch?v=MAL0ia01zIY&index=22&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW
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Δίνεται στο χρήστη η δυνατότητα για επιλογή κάποιων στοιχείων δοκών ή/και κολώνων. Στην 

επιλογή ‘’Selection’’ → ‘’Current’’ αναλύει τα επιλεγόμενα στοιχεία αλλιώς δίνεται η επιλογή ‘’All’’ 

όπου δίνει τις εσωτερικές δυνάμεις των στοιχείων. Επίσης, στην επιλογή ‘’Extreme’’ αν επιλεχθεί 

το ‘’Global’’ εμφανίζονται τα δυσμενέστερα αποτελέσματα.  

 

                             

 

 

21.2.2.  Deformations of beam 

Main → Results → Beams → Deformations of beam  
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Στη πιο κάτω περίπτωση, επιλέχθηκαν οι κολώνες στον πάνω όροφο (κατ’ επιλογή), έτσι 

παρατηρείται η παραμόρφωση των επιλεγμένων στοιχείων. Στην περίπτωση ‘’Global’’ 

εμφανίζονται μόνο οι δυσμενέστερες μετατοπίσεις (SLS) όπως φαίνεται πιο κάτω.  
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21.3. Member Stress  

 
Main → Results → Beams → Member Stress  
 
Εδώ ‘’Selection’’ → ‘’All’’ φαίνεται η ολική συμπεριφορά του κτιρίου, ενώ στη δεύτερη φωτογραφία 
παρουσιάζονται τα αποτελέσματα των στοιχείων που επιλέχθηκαν να αναλυθούν.  
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22. Acceleration of nodes  

  
Main → Results → Dynamics → Acceleration of nodes  
 
 

 

 

Type of Loads → Mass combinations  

Mass combinations – για παράδειγμα  CM 1/4 – 4.66, παρατηρείται στο συγκεκριμένο κόμβο 

(node) τι συμβαίνει - πως αντιδρά.  
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23.  2D members  

23.1. Displacement of nodes 

 
Main → Results → 2D members → Displacement of nodes 

 

 

23.2.  Internal Forces  

 

Main → Results → 2D members → Internal forces 
 

 

 

Η πλάκα του πιο πάνω μοντέλου έγινε με οπλισμένο σκυρόδεμα (2D member) - ‘’Load panel’’ 

που απλά μεταφέρει φορτία στον φορέα και δεν έχει δυσκαμψία. Αν ο χρήστης επιθυμεί η 

πλάκα να είναι από Ο/Σ θα πρέπει να συνυπολογιστεί επιπλέον στο συνολικό βάρος με 

επιπρόσθετα φορτία των μόνιμων π.χ. βάρος 10cm πλάκας= 2,5kN/m2 + 3 kN/m2 (μόνιμα). 
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23.3. Stresses / Strain 

Main → Results → 2D members → Stresses / Strain 

 

 

23.4. Tools (2D results) 

 

• Integration strips 

• Averaging strips 

 
24. Bill of material  

Main → Results → Bill of material (Estimation of quantities) 

 

Στη περίπτωση αυτή υπολογίζεται το βάρος του κάθε υλικού σε όλη τη κατασκευή.  

Αν θα έχει πλάκα από Ο/Σ θα πρέπει ΠΡΩΤΑ να γίνει η ανάλυση ή το ‘’Mesh generation’’. 

mailto:info@masesoft.com
https://help.scia.net/18.1/en/index.htm#vit/results_ppev17/integration_strips.htm%3FTocPath%3DResults%7CResults%2520on%2520slabs%7C_____16
https://help.scia.net/18.1/en/index.htm#rb/results/redistribution_strips.htm?Highlight=averaging%20strips
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25. Calculation protocol 
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Intro to Results on Supports 

 

• https://www.youtube.com/watch?v=MAL0ia01zIY&list=PL0OvQw2kgGq6RgBwrQj7cx0

kCskBg5FCW&index=22 

 

Results on 1D Members 

 

• https://www.youtube.com/watch?v=f5jCcqoIc1s&list=PL0OvQw2kgGq6RgBwrQj7cx0k

CskBg5FCW&index=23 

 

Results on 2D Members 

 

• https://www.youtube.com/watch?v=BMDFyMhXgck&list=PL0OvQw2kgGq6RgBwrQj7c

x0kCskBg5FCW&index=24 

 

3D Results 

 

• https://www.youtube.com/watch?v=yaaNZhCITnA&index=25&list=PL0OvQw2kgGq6Rg

BwrQj7cx0kCskBg5FCW 

 

Intro to Story Results 

 

• https://www.youtube.com/watch?v=vSTN9OyqS-

Q&index=26&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW 
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26. STEEL DESIGN  

 

26.1. Steel Connections 

 

• http://masesoft.com/steel-connections.html 

• https://www.youtube.com/watch?v=xNSLjSIbs0E 

 

26.2. ULS Checks  

Main → steel → Beams → ULS Checks 
 

 
 

 
 

Παρατηρείται ότι η δυσμενέστερη δοκός είναι η Β12 με Unit Check (UC) = 0.39 
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26.3. SLS Checks Relative Deformation  

Main→ Steel → Beams → SLS Checks Relative Deformation  
 

 
 

 

 
 

 

Έλεγχοι βέλους κάμψης SLS – Characteristic: 

 

→ Beams = L/250 

→ Cantilevers = L/180 

→ Beams (Bricks) = L/360 
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26.4. Steel slenderness 

Main → Steel → Steel slenderness  
 

 
 

 

26.5. Lateral – torsional buckling settings  

In case of high Unity, Section and Stability checks you may need to add LTB restraints and Member 

buckling data for steel members 

 

 
 

Θα τοποθετηθούν σημεία σε κάθε 0,111 μέτρα καθ’ ύψος της προεπιλεγμένης κολώνας, ούτως 

ώστε να αποφευχθεί ο στρεπτοκαμπτικός λυγισμός.  

mailto:info@masesoft.com
http://help.scia.net/17.0/en/index.htm#rb/steel/lateral_torsional_buckling_settings.htm%3FTocPath%3DDesign%2520of%2520steel%2520members%7CParameters%2520and%2520settings%2520for%2520code%2520checks%7C_____17
http://help.scia.net/17.0/en/index.htm#rb/steel/member_buckling_data.htm%3FTocPath%3DDesign%2520of%2520steel%2520members%7CParameters%2520and%2520settings%2520for%2520code%2520checks%7C_____14
http://help.scia.net/17.0/en/index.htm#rb/steel/member_buckling_data.htm%3FTocPath%3DDesign%2520of%2520steel%2520members%7CParameters%2520and%2520settings%2520for%2520code%2520checks%7C_____14
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27. CHECK OF CONNECTIONS 

 

27.1. Structural joints → Frame strong – axis 

Main →Steel → Connection → Structural joints → Frame strong - axis   
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Με την εντολή ‘’Frame strong – axis’’ επιλέγεται κόμβος - πλαίσιο στον ισχυρό άξονα και το 

πρόγραμμα ονομάζει το κόμβο με όνομα π. χ Conn2 N1932(Connection). Στη περίπτωση που 

επιθυμεί ο χρήστης «bottom haunch» δηλαδή να σχηματιστεί γωνιά στηριζόμενη στη κολώνα, 

το επιτυγχάνει με την εντολή ‘’Bottom haunch’’ για τροποποίηση ύψους και μήκους του 

haunch.  

Με την εντολή ‘’Bolts’’ μπορεί εύκολα να επιλέξει τον τύπο και το είδος της βίδας που θα 

χρησιμοποιήσει.  

 

• https://www.youtube.com/watch?v=k14fBDgQ06Q 

 

27.2. Structural joints → Frame weak - axis  

Main → Steel → Connection → Structural joints → Frame weak - axis  
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27.3. Structural joints → Grid pinned   

Main → Steel → Connection → Structural joints → Grid pinned   

 

• https://www.youtube.com/watch?v=zDVOrqVU0pw 

• grid pinned connection 

 
 

 
 

Bolts →  Γίνεται η επεξεργασία του τύπου των βιδών που θα τοποθετηθούν, ο αριθμός στηλών 

των βιδών, η φλάντζα κλπ.  

 

 

27.4. Structural joints → Overall check  

Main → Steel → Connection → Structural joints → Overall check  

 

Με την εντολή ‘’Overall Check’’ όπου υπάρχει σύνδεση κόμβων ελέγχεται αν είναι ΟΚ! 
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FOUNDATION DESIGN 

 
Το SCIA Engineer διαθέτει ενσωματωμένο εργαλείο για πλήρη έλεγχο θεμελιώσεων σύμφωνα 
με τον EC7. 
 
28. ΜΕΜΟΝΩΜΕΝΑ ΠΕΔΙΛΑ  

 
28.1. Supports 

Remove supports 

Main → Structure → Model data → Support → surface (el. foundation) 

 
 

28.2. Functionality  

Από Βήμα 2.1: Functionality → Pad Foundation Checks →  
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28.3. Subsoil, Foundation → Pad Foundation  

Libraries → Subsoil, Foundation → Pad Foundation  

Libraries → Load → Seismic spectrums (q-factor for concrete) 

 

Από ‘’Properties’’ τροποποιείτε την εντολή ‘’Type’’ από ‘’Standard’’ σε ‘’Pad Foundation’’ και 

εμφανίζεται πέδιλο. Αφού εφαρμοστεί σε όλες τις στηρίξεις και υπάρχουν παντού πέδιλα, ο 

χρήστης μπορεί να τα επεξεργαστεί πατώντας διπλό κλικ σε ένα πέδιλο, στη επιλογή ‘’Pad 

Foundation’’. 

     

 
 

 

Υπάρχει επιλογή για αλλαγή των παραμέτρων του πέδιλού (π.χ. μήκος, πλάτος, ύψος).  

Αυτό εξαρτάται και από το γεγονός αν το πέδιλο είναι έκκεντρο ή όχι.  
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28.4. Subsoil, Foundation  

Libraries → Subsoil, Foundation → Change Description, Parameters, Type etc 
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Για την γεωμετρία θα χρειαστεί να ενεργοποιήσετε: 

 

➔ Snap mode            

➔ View → Set view parameters > Set view parameters for all  

Ακόμη και αν εισάγατε αρχείο CAD στον κάνναβο σας, προτιμότερο θα ήταν να δημιουργήσετε και 
κάνναβο ‘’3D line grid’’. 
 
Αφου ολοκληρωθούν τα βήματα με την γεωμετρία των πεδίλων, γίνεται ανάλυση.  
 

28.5. Connect members / nodes  

Main → Structure → Model data → Connect members / nodes → Check  → Yes 
 

28.6. Check structure data 

Main → Structure → Check structure data 

 
28.7. Calculation/ Mesh  

Main → Calculation/ Mesh → Calculation  

Analysis → Batch analysis (Linear, Modal, Stability) 

 

Η ανάλυση θα διαστασιολογήσει όλα τα πέδιλα και θα δείξει το δυσμενέστερο πέδιλο, επομένως 

τα υπόλοιπα πέδιλα χρειάζονται μικρότερες διαστάσεις. 

Αφού είναι γνωστό πιο πέδιλο είναι το δυσμενέστερο, ακολουθούνται τα βήματα για αλλαγή των 

παραμέτρων του (π. χ μήκος, πλάτος, ύψος κλπ.) και ξανά ανάλυση του προγράμματος. (Βήμα 

28.6) 

 

28.8. Geotechnics  

Main → Geotechnics → Foundation Pad  Change Mx, My etc  
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Geotechnics → Foundation Pad → Refresh → Change to Current → See Result table ! 

 

Προσοχή !! Κάθε φορά που τροποποιούνται οι διαστάσεις του πεδίλου, καλό είναι να γίνεται 

ξανά ανάλυση του μοντέλου.  

 

• https://www.youtube.com/watch?v=g63LDMqV3X8 

 

• https://www.youtube.com/watch?v=5lGQQrLPVAY 

 

• https://www.youtube.com/watch?v=cpYcN1dOgD4 

 
29. Results 

Main → Results 

 

Engineering Report for steel results 

Engineering Report for concrete results 
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30. ΜΕΜΟΝΩΜΕΝΑ ΠΕΔΙΛΑ ΜΕ ΣΥΝΣΕΤΗΡΙΟΥΣ ΠΕΔΙΛΟΔΟΚΟΥΣ 

Εφαρμόζεται η ίδια διαδικασία όπως στα μεμονωμένα πέδιλα αλλά τώρα με πρόσθεση 

συνδετήριων πεδιλοδοκών.  Για την ένωση των πεδίλων μεταξύ τους δημιουργούνται συνδετήριοι 

πέδιλό-δοκοί.  

 
30.1. Functionality  

Από Βήμα 2.1: Functionality → Pad Foundation Checks →  
 

30.2. Beam 

Main → Structure → 1D member → Beam 

 

Main → Structure → Model data → Property Modifiers 1D  (0.5) 

For 1D members below ground (0 <) change ‘’Mass factor’’ to 0*. 

 

Main → Structure → Model data → Property Modifiers 2D (0.5) 

For 2D members below ground (0<) change ‘’Mass factor’’ to 0*. 

   

* ‘’Mass factor’’ has to be zero (0) because foundations and basements have no movement 

because according to codes they are non-sway members. 
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30.3. Support  

Main → Structure → Model data → Support → Line on beam 

 

Type → Foundation strip  

Width b [m] → Edit 

Hight h [m] → Edit 
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30.4. Libraries → Load → Seismic spectrums (q-factor for concrete) 

Main → Libraries → Load → Seismic spectrums (q-factor for concrete) 
 

30.5. Connect members / nodes  

Main → Structure → Model data → Connect members / nodes → Check  → Yes 
 

30.6. Check structure data 

Main → Structure → Check structure data 

 
30.7. Calculation/ Mesh  

Main → Calculation/ Mesh → Calculation  
Analysis → Batch analysis (Linear, Modal, Stability) 
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30.8. Combinations → ULS Set C 

Main  → Load Case, Combination → Combinations → ULS Set C 
 

 
 

 
 
 
Μέσα από τον Ευρωκώδικα 8, το ελάχιστο πλάτος για συνδετήριους πεδιλοδοκούς είναι 
bw,min=0.25m ενώ το ελάχιστος ύψος είναι hw,min = 0.50m. Στο μοντέλο ανάλυσης που αναλύεται 
στο πρόγραμμα είναι bw = 0,3 m και hw = 0,50 m.  
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5.8.2 Tie-beams and foundation beams (Συνδετήριες μεμονωμένοι πεδιλοδοκοί) 
 
(3) Tie-beams and foundation beams should have a cross-sectional width of at least 
bw,min and a cross-sectional depth of at least hw,min . 
 
NOTE The values ascribed to bw,min and hw,min for use in a country may be found in its National Annex to 
this document. The recommended values are: bw,min = 0,25 m and hw,min = 0,4 m for buildings with up to 
three storeys, or hw,min = 0,5 m for those with four storeys or more above the basement.  

 
 
 
31. Έλεγχος δοκών θεμελίωσης 

 
31.1. Reinforcement design  

Main → Concrete → Reinforcement design → 1D member → Slenderness  
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31.2. 1D member → Reinforcement design  

 
Main → Concrete → Reinforcement design → 1D member → Reinforcement design  
 
Χωρίς να οπλιστεί η πεδιλοδοκός, εμφανίζεται ο απαιτούμενος θεωρητικός οπλισμός.  
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31.3. Reinforcement Check (ULS + SLS)  

 
Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Internal forces   
 
Εφόσον θέλετε να οπλίσετε τις πεδιλοδοκούς, γίνεται ο απαιτούμενος έλεγχος των οπλισμών σε 
αυτές.  
  

 
 
 
31.4. Reinforcement Check (ULS + SLS) → Slenderness 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Slenderness 
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31.5. Reinforcement Check (ULS + SLS) → Stiffnesses 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Stiffnesses 
 

 
 
 
31.6. Reinforcement Check (ULS + SLS) →Capacity – response (ULS) 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Capacity – response 
(ULS) 
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31.7. Reinforcement Check (ULS + SLS) → Capacity – diagram (ULS) 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Capacity – diagram 
(ULS) 
 

 
 
Με την εντολή Output → Detailed έχω την επιλογή μέσω του ‘’Preview’’ να δω το διάγραμμα 
αλληλεπίδρασης (Interaction diagram). 
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31.8. Reinforcement Check (ULS + SLS) → Shear + Torsion (ULS) 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Shear + Torsion 
(ULS) 
 

 
 
 
31.9. Reinforcement Check (ULS + SLS) →Stress Limitation (SLS) 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Stress Limitation 
(SLS)  
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31.10. Reinforcement Check (ULS + SLS) → Deflections (SLS) 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Deflections (SLS) 
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31.11. Results 

31.11.1. Beams  

Main → Results → Beams → Internal forces on beam strip (√) 

 

 

31.11.2. 2D results 

Main → Results → Tools 2D results → Integration strip (Strip foundation)      

 

 

31.11.3. Member design 

Main → Concrete → 2D member → Member design → Member design ULS  

                                                                       Properties → Use scale isolines 

 

31.11.4. Reinforcement design 

Main → Concrete → Reinforcement design → 2D members → Reinforcement design (ULS) 
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31.11.5. Section Checks – results  

Main → Concrete → Section checks – results → Section check  

 

H εντολή «Section checks – results» περιλαμβάνει τον καθορισμό και τον έλεγχο των ράβδων 

οπλισμού που αφορά σεισμικά φάσματα σύμφωνα με τα πρότυπα του Ευρωκώδικα 2. 

 

 

Με την εντολή «Section check» ο χρήστης επιλέγει ένα πεδιλοδοκό (rips) της επιλογής του, 

πατώντας τον κόμβο και εμφανίζεται το πιο κάτω παράθυρο. Μπορεί κανείς να παρατηρήσει ότι 

όλοι οι έλεγχοι είναι αποδεκτοί αφού εμπίπτουν εντός των επιτρεπόμενων ορίων.  

 

 

 

 

 

 

31.11.6. Engineering Report for steel results (Βλέπε Κεφάλαιο 33) 

31.11.7. Engineering Report for concrete results (Βλέπε Κεφάλαιο 33) 
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32. ΓΕΝΙΚΗ ΚΟΙΤΟΣΤΡΩΣΗ ΜΕ ΚΡΥΦΟΔΟΚΟΥ 

 

Η θεμελίωση με γενική κοιτόστρωση εφαρμόζεται κυρίως όταν το έδαφος δεν είναι πολύ 

ανθεκτικό - ασταθές έδαφος. Η λειτουργία της κοιτόστρωσης μοιάζει με τη λειτουργία μίας 

σχάρας πεδιλοδοκών. 

 

Στη γενική κοιτόστρωση οι ισχυρότερες τάσεις που δημιουργούνται είναι στην περιοχή των 

υποστυλωμάτων και οι ασθενέστερες τάσεις στις ενδιάμεσες περιοχές. Όταν υπάρχουν δοκοί 

ενίσχυσης, τότε οι τάσεις στο έδαφος έχουν μικρότερη απόκλιση μεταξύ των περιοχών των 

υποστυλωμάτων και των ενδιάμεσων περιοχών της κοιτόστρωσης. Αν ο χρήστης επιθυμεί 

βέλτιστη σύνδεση/ ένωση της γενικής κοιτόστρωσης, μπορεί να τοποθετήσει κρυφοδοκούς. 

 

32.1. 2D Members → Plates  

 

Main → Structure → 2D Members → Plates → Plate (Concrete) 
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Στο παρόν μοντέλο για την τοποθέτηση κρυφοδοκών χρησιμοποιήθηκαν rips και όχι beams, 
παρόλα αυτά είναι στη κρίση του κάθε Μηχανικού η τακτική που θα ακολουθηθεί.  
 

32.2. Support  

 

Remove supports 

Main → Structure → Model data → Support → Surface (el. Foundation) 
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32.3. Property Modifiers 2D  

Main → Structure → Model data → Property Modifiers 2D (0.5) 

For 2D members below ground (0<) change ‘’Mass factor’’ to 0*. 

Stiffness factor = 0.5 

 

  
   

* «Mass factor» has to be zero (0) because 

foundations and basements have no movement 

because according to codes they are non-sway 

members. 

 

 

32.4. Reinforcement design  

Main → Concrete → Reinforcement design → 1D member → Reinforcement design  
 
Χωρίς να οπλιστεί η κρυφοδοκός ή/και η γενική κοιτόστρωση, εμφανίζεται ο απαιτούμενος 
θεωρητικός οπλισμός.  
 
 
32.5. Reinforcement 2D 

Main → Concrete → Reinforcement input & edit →1D members → Reinforcement 2D 

 

Αφού επιλεχθεί η γενική κοιτόστρωση εμφανίζεται αυτόματο μήνυμα του προγράμματος, αν ο 

χρήστης επιθυμεί να οπλιστεί ολόκληρο το μέλος που έχει επιλεχθεί. Αφού οπλιστεί αυτόματα, ο 

χρήστης έχει την δυνατότητα να αλλάξει τους οπλισμούς.  

 

 

mailto:info@masesoft.com


91 
 

Official Partner of SCIA in Cyprus 
 

Franklin Roosevelt 193, 3045, Limassol, Cyprus 

Tel: +357 25251718, Mob: +357 97614727 

Email: info@masesoft.com 

32.6. Reinforcement 2D 

Main → Concrete → Reinforcement input & edit →1D members → New Reinforcement 

 

Ο χρήστης επιλέγει τον κρυφοδοκό της γενικής κοιτόστρωσης και επιλέγει σημεία από κόμβο σε 

κόμβο για τη δημιουργία νέου οπλισμού. Ακολούθως, εμφανίζονται τα ακόλουθα βήματα.  
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Αν ο χρήστης επιθυμεί να τροποποιήσει τον οπλισμό, μπορεί να επιλέξει τον οπλισμό της 
γενικής κοιτόστρωσης ή/και των κρυφοδοκών και από τα “Properties” να αλλάξει τη διάμετρο 
των ράβδων, την επικάλυψη κλπ.  
 

 
 
Το ίδιο συμβαίνει και με τους συνδετήρες των κρυφοδοκών. Επιλέξτε τους συνδετήρες και από τα 
“Properties”, υπάρχει επιλογή για αλλαγή απόστασης μεταξύ τους, τη διάμετρο των ράβδων 
κλπ.  
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ENGINEERING REPORT 

 
32.7. Engineering report 
Main → Engineering report 
 

Μέσω του Engineering Report εισάγονται όλα τα δεδομένα που 
σχετίζονται με τη μελέτη, επεξηγούνται οι λεπτομέρειες της μελέτης 
που κυμαίνονται από προσδιορισμό των δεδομένων της μελέτης στα 
στατικά αποτελέσματα της ανάλυσης, εισάγονται όλοι οι έλεγχοι 
σχεδιασμού του κτηρίου αλλά και τα σχέδια μελέτης που μπορεί 
εύκολα τόσο ο μελετητής όσο και η ομάδα αποπεράτωσης του έργου 
να τα αντιληφθεί.  
 
Επιπλέον, εύκολα μπορούν να ομαδοποιούνται δεδομένα της 
μελέτης και να εισάγονται εικόνες που αντιστοιχούν στα δεδομένα 
αυτά.  
 
Με την εντολή ‘’Engineering Report’’ ανοίγει παράθυρο στο οποίο 
με την εντολή ‘’New’’, μεταφέρεται στο report για αν το 
επεξεργαστούμε.   
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Διπλό κλίκ για να ανοίξει το 
παράθυρο του report και να το 
επεξεργαστούμε.   
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Main → Engineering report → Insert  
 
 

 
 
 
Στα αριστερά του παραθύρου εμφανίζονται όλες οι επιλογές που παρέχονται από το πρόγραμμα 
ούτως ώστε να εισαχθούν ότι θεωρείται από τον Μηχανικό απαραίτητο και σημαντικό για το report.  
Πιο κάτω φαίνονται κάποιες από τις επιλογές και πως χρησιμοποιούνται.  
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Special items → Head and Footer  
  → Table of Contents  
  → Page Break 
  → Chapter → Properties → General 
 
Libraries →Material  
    → Cross section 

   → Subsoils 
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Από εντολή ‘’Regenerate’’, και με τη χρήση του προγράμματος Scia Engineer, δεξί κλικ εμφανίζεται 
το πιο κάτω. 
Με την εντολή ‘’Live Picture in scale into Engineering report’’, προστίθεται η εικόνα του μοντέλου 
στο ‘’Engineering report’’.  
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32.8. Nodes, Member, 2D member 
 
Main → Engineering report → Structure 
 
Για να ενταχθούν τα χαρακτηριστικά των μελών, κόμβων κ.λπ. (Nodes, Member, 2D member 
etc) στο ‘’Engineering report’’, επιλέγουμε την εντολή ‘’Structure’’  → Nodes 
                           → Member  
                           → 2D Member  
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32.9. Loads  
 
Main → ’’Engineering report’’ → ‘’Sets’’ προθέτονται τα ‘’Load Cases’’ στο engineering report.  
Για να εμφανίζεται εικόνα των ‘’Load Cases’’, πηγαίνουμε στο πρόγραμμα ‘’Main → Load’’. 
 
Από εντολή ‘’Regenerate’’, και με τη χρήση του προγράμματος Scia Engineer, δεξί κλικ εμφανίζεται 
το πιο κάτω. Με την εντολή ‘’Live Picture in scale into Engineering report’’, προστίθεται η εικόνα 
του μοντέλου στο ‘’Engineering report’’.  
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32.10. Results  
 

Για να προστεθούν τα αποτελέσματα του μοντέλου από το πρόγραμμα SCIA Engineer, 
ακολουθούνται τα παρακάτω βήματα.  
 
Main →Engineering Report → Report Template → System templates → 1D 
Internal forces 
 
Με την επιλογή ‘’1D Internal forces’’, παρουσιάζονται οι φορτίσεις (αξονικές, 
ροπές) της κατασκευής. 
 
Στις πιο κάνω εικόνες αναλύονται τα αξονικά φορτία της κατασκευή, οι ροπές 
στον x – άξονα, ροπές στον y- άξονα, ροπές στον z- άξονα.  
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Περισσότερες πληροφορίες όσον αφορά το Engineering Report μπορείτε να επισκεφτείτε τους 
πιο κάτω συνδέσμους.  
 

• SCIA ENGINEER: ENGINEERING REPORT TEMPLATES 

• Engineering Report - Τεύχος Υπολογισμών 

• Engineering Report 
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